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IMPORTANT SAFEGUARDS AND WARNINGS

Prior to installation and use of this product, the following WARNINGS should be observed.

1. Installation and servicing should be done only by qualified service personnel and conform to all local codes.

2. Unless the unit is marked specifically as a NEMA Type 3, 3R, 3S, 4, 4X, 6, or 6P enclosure, it is designed for indoor use
only and it must not be installed where exposed to rain and moisture.

3. The installation method and materials should be capable of supporting four times the weight of the unit and equipment.

The product and/or manual may bear the following marks:

Please thoroughly familiarize yourself with the information in this manual prior to installation and operation.

CAUTION:  Do not run any software applications on the viewstation other than those authorized by Pelco.

This symbol indicates that dangerous voltage constituting a risk of
electric shock is present within this unit.

This symbol indicates that there are important operating and mainte-
nance instructions in the literature accompanying this unit.

CAUTION:
RISK OF ELECTRIC SHOCK.

DO NOT OPEN.
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Figure 1.  DX9000 System Overview

DESCRIPTION

The DX9000 system consists of at least one digital video recorder (DVR), one viewstation, and one storage unit.

The DX9000 digital video recorder can record images simultaneously from as many as 40 cameras at 15 images per second
(ips) or from as many as 24 cameras at 30 ips. There are two types of recorders. One is compatible with DX9000HDDS storage
units and one is compatible with DX9200HDDI storage units.

Thousands of cameras can be recorded and viewed at the same time when multiple DX9000 recorders and viewstations are
linked to each other through a local area network (LAN) or wide area network (WAN).

The DX9000VS-C viewstation has these features:

• Simultaneous viewing of live or recorded video can be seen from as many as four cameras.
• Live video can be marked for later review by the user or via motion detection.
• Scan feature allows the user to search recorded video for movement of a specific object.
• Video files can be saved in MPEG format to a compact disk, hard drive, or anywhere on the network.
• A current video frame can be printed on a standard PC printer.
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SCSI STORAGE UNIT

o
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MODELS

DX9000VS-C Viewstation

DX9008F-C 8-channel recorder, 30 ips per camera, Revision C software, compatible with DX9000HDDS
DX9016F-C 16-channel recorder, 30 ips per camera, Revision C software, compatible with DX9000HDDS
DX9024F-C 24-channel recorder, 30 ips per camera, Revision C software, compatible with DX9000HDDS
DX9008H-C 8-channel recorder, 15 ips per camera, Revision C software, compatible with DX9000HDDS
DX9016H-C 16-channel recorder, 15 ips per camera, Revision C software, compatible with DX9000HDDS
DX9024H-C 24-channel recorder, 15 ips per camera, Revision C software, compatible with DX9000HDDS
DX9032H-C 32-channel recorder, 15 ips per camera, Revision C software, compatible with DX9000HDDS
DX9040H-C 40-channel recorder, 15 ips per camera, Revision C software, compatible with DX9000HDDS

DX9008F-CI Same as DX9008F-C, except compatible with DX9200HDDI
DX9016F-CI Same as DX9016F-C, except compatible with DX9200HDDI
DX9024F-CI Same as DX9024F-C, except compatible with DX9200HDDI
DX9008H-CI Same as DX9008H-C, except compatible with DX9200HDDI
DX9016H-CI Same as DX9016H-C, except compatible with DX9200HDDI
DX9024H-CI Same as DX9024H-C, except compatible with DX9200HDDI
DX9032H-CI Same as DX9032H-C, except compatible with DX9200HDDI
DX9040H-CI Same as DX9040H-C, except compatible with DX9200HDDI
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INSTALLATION

Make sure all parts are present for each unit.

Recorder

1 Recorder
2 Power cords (1 USA standard and 1 European standard)
2 Brackets

6 Screws, 8-32 x .250-inch, pan head
2 Rack ears

4 Screws, 10-32 x .250-inch, flat head
4 Screws, 10-32 x .750-inch, Phillips, pan head with washers

2 Rear mounting rails
8 Screws, 10-32 x .375-inch, flat head

2 Front mounting rails
6 Screws, 8-32 x .375-inch, pan head with washers

4 Screws, 10-32 x .375-inch, flat head
1 Patch panel

1-5 BNC mounting plates (minimum 8 inputs; maximum 40 inputs)
1-5 37-pin connectors with 24-inch (61 cm) sets of coaxial cable and BNC connectors
2-10 Screws, 6-32 x .375-inch, Phillips, pan head with lock washers
4 Screws, 10-32 x .750-inch, Phillips, pan head with washers

2 Keys
1 Windows® 2000 package
4 Windows boot disks
1 Emergency repair disk
1 pcAnywhere™ package
1 Resource CD

Viewstation

1 Viewstation
2 Power cords (1 USA standard and 1 European standard)
1 PS2 keyboard
1 PS2 mouse
1 Analog video output adapter cable
1 Modem cable
2 Brackets

6 Screws, 8-32 x .250-inch, pan head
2 Rack ears

5 Screws, 10-32 x .250-inch, flat head
4 Screws, 10-32 x .750-inch, Phillips, pan head with washers

2 Rear mounting rails
8 Screws, 10-32 x .375-inch, flat head

2 Front mounting rails
6 Screws, 8-32 x .375-inch, pan head with washers
5 Screws, 10-32 x .375-inch, flat head

2 Keys
1 Windows 2000 package
4 Windows boot disks
1 Emergency repair disk
1 pcAnywhere package
1 Resource CD
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INSTALLATION GUIDELINES

You must adhere to the following guidelines for optimum system performance.

• The DX9000 recorders and storage units require connection to an Uninterruptible Power Supply (UPS) to ensure no
corruption of data during a power loss.

• The DX9000 system must be installed in a climate-controlled room. The temperature range should be 41˚ to 85˚F (5˚ to
29˚C).

• All network devices that will transport DX9000 video must be capable of moving multicast traffic.

• Pelco recommends that the DX9000 recorder and storage units be installed in a ventilated rack enclosure. Never secure
the recorder or storage units to the rack enclosure using only the front handles.

• Make sure the rack enclosure is properly grounded.

• Pelco recommends that a spare phone line be installed and connected to a primary DX9000 viewstation to allow the
Pelco Technical Support Group to dial into the site upon customer request. Pelco personnel will not make changes unless
authorized by the customer. This phone line can be password protected to prevent unauthorized access.

Lack of adherence to these guidelines gives Pelco discretion in honoring product warranty.
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Figure 2.  Recorder/Viewstation Rack-Mount Installation

RACK

RECORDER/VIEWSTATION

(6) SCREWS, 8-32 X .250-INCH
PAN HEAD (3 EACH SIDE)

(4) SCREWS,
10-32 X .375-INCH
FLAT HEAD

(8) SCREWS,
10-32 X .375-INCH,
FLAT HEAD

BRACKET
(SIDE VIEW)

SLOTTED HOLES
TOWARDS FRONT
OF UNIT

TAPERED ENDS
TOWARDS REAR
OF UNIT

(4) SCREWS,
10-32 X .750-INCH
PHILLIPS, PAN HEAD
WITH WASHERS

REAR MOUNTING RAIL

FRONT MOUNTING RAIL
(6) SCREWS,
8-32 X .375-INCH,
PAN HEAD WITH
WASHERS

RACK EAR

MOUNTING

The recorder and viewstation are supplied with the necessary parts for mounting into an industry standard 19-inch (48.26 cm)
wide equipment rack. The recorder should be connected to an uninterruptible power supply (UPS) capable of supplying 2 A for
120 VAC power systems or 1 A for 230 VAC power systems.

CAUTION:  The units should be installed in an air-conditioned room where the temperature is maintained between
41° and 86°F (5° and 29°C).

The units can be placed on a flat surface, such as a shelf, or can be installed in a 19-inch wide equipment rack.

NOTE:  Allow one rack unit (1.75 inches or 4.5 cm) of space between each unit for air circulation.

To install the units in an equipment rack:

1. Attach the two rack ears to both sides of each unit.
2. Attach the two brackets to both sides of each unit.
3. Attach the mounting rails to the equipment rack.
4. Place the units onto the mounting rails. They should slide in and out of the rack easily.
5. Fasten the rack ears to the equipment rack.
6. Attach the patch panel to the rear of the rack.

The following illustration shows how to mount a recorder or a viewstation into a rack.
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CONNECTIONS

The steps and Figures 3 and 4 show how to connect the units to each other and to a network. A dedicated LAN of four or more
viewstations requires a minimum network of 100BaseT (100 Mbit/sec). Integration within an existing LAN/WAN requires a
network of 100BaseT (100 Mbit/sec).

1. Connect the viewstation to the recorder via an Ethernet switch. Use shielded network cables.

2. Connect a monitor, keyboard, and mouse to the viewstation.

3. Connect up to five 37-pin connectors to the recorder.

4. Connect cameras to the recorder.

5. Connect the storage units to the recorder. Refer to the IDE or SCSI Installation/Operation manual for more information.

6. Connect all power cords.

7. Turn on the storage units and let them run for at least one minute (the hard disk drives must spin through their warm-up
cycle).

8. Turn on the recorder and let it boot for at least 30 seconds.

9. Turn on the viewstation.
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Figure 3.  DX9000 System Connections (SCSI)

WARNING:  The SCSI cables that connect the storage unit to the recorder are sensitive in nature. DO NOT tie them together in
any way. Doing so may damage the cables and render the system inoperable. These cables must hang loosely in the rack.
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Figure 4.  DX9000 System Connections (IDE)

WARNING:  The SCSI cables that connect the storage unit to the recorder are sensitive in nature. DO NOT tie them together in
any way. Doing so may damage the cables and render the system inoperable. These cables must hang loosely in the rack.
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Figure 5.  Recorder Network Identification Page

PROGRAMMING

You must use pcAnywhere to access a DX9000 recorder and configure it. You can find a shortcut to the pcAnywhere application
on your viewstation desktop.

RECORDER NETWORK CONFIGURATION

After you make all connections, you have to configure the network on the recorder. To configure the recorder, you need the
following information. You can obtain this information from your network administrator.

• Unique recorder name: (Examples are Pelco1, Pelco2, Pelco3, etc. This is the default naming scheme.)

• Unique IP address: (Examples are 100.0.0.101, 100.0.0.102, 100.0.0.103, etc. This is the default addressing scheme.)

• Network subnet mask: This must be the same on all recorders and viewstations. (For example, 255.0.0.0 is the default.)

• Computer workgroup name: This must be the same on all recorders and viewstations. (For example, DX9000_GROUP is
the default.)

• Viewstation name: These are the name(s) of the viewstation(s) to be alerted when there are storage box problems.

CHANGING THE RECORDER’S IDENTIFICATION
To change the default computer name or workgroup:

1. Close all windows on the recorder desktop.
2. Right-click My Computer.
3. Go to Properties and click the Network Identification tab.
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4. Click Properties.

Figure 6.  Recorder Identification Changes Dialog Box

5. Enter the new computer name or workgroup.
6. Click OK.
7. Reboot.

It takes about five minutes for the recorder to reboot. If you cannot wait that long, then wait two minutes, open the recorder
door, and turn the power off and back on.
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CHANGING THE RECORDER’S IP ADDRESS
To change the recorder’s IP address:

1. Close all windows on the recorder desktop.

2. Right-click My Network Places and go to Properties.

Figure 7.  Recorder Network Connections Window
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Figure 9.  Recorder Local Area Connection Properties Dialog Box

5. Make sure the “Show icon in taskbar when connected” checkbox is selected.

Figure 8.  Recorder Local Area Connection Status Dialog Box

4. Click Properties.

3. Double-click Local Area Connection.
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Figure 10.  Recorder Internet Protocol (TCP/IP) Properties Dialog Box

7. Enter the IP address (For example, 100.0.0.101). The last three digits must be different for each recorder (For example,
101, 102, 103, etc.).

8. Enter the Subnet mask.

NOTE:  You may also have to enter your default gateway address and your DNS server address(es).

9. Click OK.

NOTE:  After changing the recorder’s IP address, you must go to the Server Configuration Utility. The numbers in the last three
boxes of the “Multicast group” must match the last three numbers of this recorder’s IP address.

6. Double-click Internet Protocol (TCP/IP).
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VIEWSTATION NETWORK CONFIGURATION

After you make all connections, you also have to configure the network on the viewstation. To configure the viewstation, you
need the following information. You can obtain this information from your network administrator.

• Unique viewstation name: (Examples are Pelcovs1, Pelcovs2, Pelcovs3, etc. This is the default naming scheme.)

• Unique IP address: (Examples are 100.0.0.201, 100.0.0.202, 100.0.0.203, etc. This is the default addressing scheme.)

• Network subnet mask: This must be the same on all recorders and viewstations. (For example, 255.0.0.0 is the default.)

• Computer workgroup name: This must be the same on all recorders and viewstations. (For example, DX9000_GROUP is
the default.)

CHANGING THE VIEWSTATION’S IDENTIFICATION
To change the default computer name or workgroup:

1. Close all windows on the viewstation desktop.
2. Right-click My Computer.
3. Go to Properties and click the Network Identification tab.

Figure 11.  Viewstation Network Identification Page

4. Click Properties.
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Figure 12.  Viewstation Identification Changes Dialog Box

5. Enter the new computer name or workgroup.
6. Click OK.
7. Reboot.
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CHANGING THE VIEWSTATION’S IP ADDRESS
To change the viewstation’s IP address:

1. Close all windows on the viewstation desktop.

2. Right-click My Network Places and go to Properties.

Figure 13.  Viewstation Network Connections Window

3. Double-click Local Area Connection.
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Figure 15.  Viewstation Local Area Connection Properties Dialog Box

5. Make sure the “Show icon in taskbar when connected” checkbox is selected.

Figure 14.  Viewstation Local Area Connection Status Dialog Box

4. Click Properties.
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Figure 16.  Viewstation Internet Protocol (TCP/IP) Properties Dialog Box

7. Enter the IP address (For example, 100.0.0.201). The last three digits must be different for each viewstation (For example,
201, 202, 203, etc.).

8. Enter the Subnet mask.

NOTE:  You may also have to enter your default gateway address and your DNS server address(es).

9. Click OK.

6. Double-click Internet Protocol (TCP/IP).
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CLIENT CONFIGURATION UTILITY

You can use this utility to build a list of local servers and to synchronize the time between recorders and viewstations.

1. Go to Start > Programs > DX9000 Viewstation > Client Configuration Utility.

Figure 17.  Client Configuration Login Dialog Box

2. Enter admin in the “User name” field and admin in the “Password” field.

3. Click Login.

Figure 18.  Client Configuration Utility

4. Select “Build a list of local servers.”

5. Select “Standard naming” or “Custom naming.”

a. Standard Naming: Select this option if all of your recorders have the same name and the only difference is the
numbers.

b. Custom Naming: If your recorders have different names, enter the names and click Add.

6. Click Configure.
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Figure 20.  Operation Complete Dialog Box

8. Click OK.

Figure 21.  Client Configuration Success Dialog Box

9. Click Close.

Figure 19.  Verify Settings Dialog Box

7. Click Yes.
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TIME SYNCHRONIZATION
All equipment in your system must have the same time. Pelco recommends you select all recorders as time synchronization
recorders. Creating this chain ensures that the system will maintain the correct time in case one or more recorder fails. All
recorders and viewstations must belong to the same workgroup or local area network (LAN).

Follow these steps for each viewstation:

1. Make sure that each viewstation is connected to the network switch.
2. Right-click the “Time Synchronizer” icon in the viewstation system tray and select “Exit.”

NOTE:  Use pcAnywhere to access each viewstation and exit the Time Synchronizer.

3. Make sure the Date/Time Properties are correct on each viewstation. You can access the date and time from the system
tray.

Follow these steps for each recorder:

1. Make sure that each recorder is connected to the network switch.
2. Right-click the “Time Synchronizer” icon in the recorder system tray and select “Exit.”

NOTE:  Use pcAnywhere to access each recorder and exit the Time Synchronizer.

3. Make sure the Date/Time Properties are correct on each recorder. You can access the date and time from the system tray.

After you complete these steps, you must open the Client Configuration Utility. It is used to synchronize the time between the
recorders and viewstations.

Follow these steps:

1. Click “Configure time zone.”

Figure 22.  Time Zone Editor Dialog Box

2. Verify your time zone.
3. Click Edit.
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Figure 23.  Edit Time Zone Dialog Box

4. Verify that the “Automatically set Daylight Saving Time” checkbox is selected, if applicable for the location of installation.
5. Click OK.
6. Close the Windows® NT Time Zone Editor.
7. Click Configure.

Figure 24.  Verify Settings Dialog Box

8. Click Yes.

Figure 25.  Operation Complete Dialog Box

9. Click OK.
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10. Select the “Export to server” radio button.

Figure 26.  Export to Server Dialog Box

11. Select the name of the first recorder from the drop-down box.
12. Click Configure.

Figure 27.  Verify Settings Dialog Box

13. Click Yes.

Figure 28.  Operation Complete Dialog Box

14. Click OK.

NOTE:  You must follow these steps for each recorder that is in the drop-down box.

Refer to the Server Configuration Utility section to complete time synchronization.
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SERVER CONFIGURATION UTILITY

Windows should boot up to the desktop without user intervention. Make sure all applications on the recorder are closed.

1. Go to Start > Programs > DX9000 Server > DX9000 Server Configuration Utility.

Figure 29.  Server Configuration Utility Dialog Box

Table A describes the Initialization Options. These options are preconfigured. The only checkbox you should select is “Define
time synchronization chain.”
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Table A.  Initialization Options

Option Description

Initialize New Channels The number of channels for the recorder is displayed. Half or Full frame rate is selected. The
Quarter frame rate setting is reserved for future development.

Recording Format The recording format is set for your location: PAL or NTSC.

Resolution CIF resolution is selected. The 2CIF resolution setting is reserved for future development.

Multicast Group 239 is displayed in the first text box. The numbers in the last three boxes should match the last
three numbers of this recorder’s IP address. For example, if your IP address is 100.0.0.101, then
your Multicast Group is 239.0.0.101.

Multicast TTL These are the total number of routers that separate the server from its farthest viewstation on
the network. For example, if two routers separate the server from its farthest viewstation, then
the value will be 2.

Alarm Interval This is the alarm interval (listed in seconds) for the cameras associated with this recorder. The
default is 300 seconds. This feature is relevant only if you do not intend on recording
continuously (24 hours a day), and want to record events only during part or all of the day.

Pre-Alarm Interval This is the pre-alarm interval (listed in seconds) for the camera associated with this recorder.
The default is 60 seconds. This feature is relevant only if you do not intend on recording
continuously (24 hours a day), and want to record events only during part or all of the day.

Auto Record Auto record means that the system begins to record automatically when rebooted. The system
does not record automatically if you select the “False” radio button

Define Time
Synchronization Chain This allows you to configure the recorders that you exported in the Client Configuration Utility.

2. Click Configure Time Zone.

Figure 30.  Time Zone Editor Window

3. Verify your time zone.
4. Click Edit.
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Figure 31.  Edit Time Zone Dialog Box

5. Verify that the “Automatically set Daylight Saving Time” checkbox is selected, if applicable for the location of installation.
6. Click OK.
7. Close the Windows NT Time Zone Editor.
8. Click Configure.

Figure 32.  Verify Settings Dialog Box

9. Click Yes.

Figure 33.  Operation Complete Dialog Box

10. Click OK.
11. Select the “Define time synchronization chain” checkbox from the Server Configuration Utility dialog box.
12. Click Suggest. The recorders that you exported previously from the Client Configuration Utility appear.
13. Click Configure.
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MYLEX ALERT MANAGER

NOTE:  The Mylex Alert Manager is not available on the IDE-compatible recorders.

The Mylex Alert Manager sends an alert to DX9000 viewstations whenever there is a problem. The Workstation Array
Manager application should be running in the background all the time. For example, if a hard disk drive storage unit fails, the
application appears onscreen.

To create a server alert file:

1. Click My Computer from your desktop.

2. Click Local Disk (C:).

3. Click Program Files.

4. Click Mylex.

5. Click the Workstation Array Manager folder.

Figure 34.  Workstation Array Manager Window

6. Go to File > New > Text Document.

7. Name the new text file Server Alert.

Download from Www.Somanuals.com. All Manuals Search And Download.



C662M-E (5/03) 35

Figure 35.  New Text Document Window

8. Double-click the file. Notepad opens.
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9. Enter the name of the DX9000 viewstation you want to alert and then enter the event message text. Follow the example
below.

Figure 36.  Example Event Message Text Window

NOTE:  Duplicate the line if you want to alert more than one viewstation. Remember to specify the viewstation names.

10. Save your changes and close Notepad.

11. Go to Tools > Folder Options > View.
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Figure 37.  Folder Options Page

12. Uncheck “Hide file extensions for known file types.”

13. Click Apply and then OK.

14. Rename Server Alert.txt to Server Alert.bat.

Figure 38.  Rename File Dialog Box

15. Click Yes.
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Figure 39.  Server Alert Batch File Window
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To set the settings for events:

1. Go to Start > Programs > Startup > Mylex Workstation Array Manager 3.01.

Figure 40.  Workstation Array Manager Window

2. Click .
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Figure 41.  Alert Preferences Page

3. Make sure “Append to log file” and “Enable event logging” are selected.
4. Select the event security level(s) in the Launch Application section. Refer to Table B.
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Table B.  Security Levels

Priority Event Definition Example

0 Critical Controller is dead. System is disconnecting from this controller.
Controller is gone. System is disconnecting from this controller.
Bad blocks found.
Controller is using default non-unique world-wide name.
Mirror race on critical drive.

1 Serious A hard disk has failed.
Physical drive missing on startup.
Fan failure.
Over temperature.
Power supply failure.
Uninterruptible power supply failed.
Back end SCSI bus dead.
Controller firmware mismatch.
Controller Boot ROM Image needs to be reloaded.
Lost connection to server, or server is down.

2 Error Rebuild stopped because logical drive failed.
Expand capacity stopped with error.
Consistency check on logical drive error.
Logical drive is critical.
Logical drive initialization failed.
Data for disk block has been lost due to logical drive problem.
Write back error.
Mirror race recovery failed.

3 Warning New configuration.
Controller entered conservative cache mode.
Controller has been reset.
Enclosure access critical.
Uninterruptible power supply battery low.
SCSI command timeout on hard device.

4 Informational Initialization started.
Logical drive background initialization started.
Fan has been restored.
Power supply has been restored.
Access to temperature sensor has been lost.
Access to fan status information has been lost.
Uninterruptible power supply normal.
Storage works enclosure reported normal state.
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5. Click the Alarm Setup tab.

Figure 42.  Alarm Setup Page

6. Select Launch Application and then click Add.

Figure 43.  Launch Application Dialog Box

7. Make sure the “Enabled” checkbox is selected and the “Launch Only Once” checkbox is not selected.
8. Click Browse.
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Figure 44.  Select Batch File Dialog Box

9. Select Server Alert.bat and then click Open.

Figure 45.  Application Name Dialog Box
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10. Click Test. The message below appears on the recorder and Messenger Service opens on the viewstation.

Figure 46.  Application Test Window

Figure 47.  Messenger Service Dialog Box

11. Click OK.

Figure 48.  Successful Test Page

12. Click OK.
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SETTING UP THE SYSTEM

System administrators and operators with a Level 1 authorization can set camera recording properties. However, only system
administrators can define user names and passwords for the DX9000 viewstation.

To open the DX9000 viewstation application, double-click the desktop icon and log in.

CAMERA RECORDING PROPERTIES
1. Click System > Properties on the main toolbar.

Figure 49.  Camera Properties Dialog Box

2. Click “Select channel” to display a list of recorders.
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Figure 50.  Select Channel Dialog Box

3. Select a channel.

Download from Www.Somanuals.com. All Manuals Search And Download.



C662M-E (5/03) 47

Figure 51.  Continuous Recording Schedule Page

4. Select the “Preview” checkbox to verify that you have the correct camera.
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Continuous Recording Schedule
1. Select the “Continuous recording” radio button. (This is the default setting and should be selected already when you

select a channel.)

2. Click Apply.

Recording is done at all times and no schedule is defined. The entire daily and weekly recording schedules are marked in light
yellow, and any previous definitions on the schedules are removed.
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Figure 53.  Daily Event Recording Page

Figure 52.  Continuous Daily Recording Schedule Page

The example below shows daily event recording from 7:05 A.M. to 12:05 P.M. The box in the time bar is yellow with a red
border. You can make the box smaller or larger by dragging it using your mouse.

Daily Recording Schedule
1. Select the “Daily recording schedule” radio button.
2. Click in the time bar the desired starting time for recording or enter the exact start/end times in the “Fine tune” fields.

The example below shows continuous daily recording from 7:05 A.M. to 12:05 P.M. The box in the time bar is blue with a red
border. You can make the box smaller or larger by dragging it using your mouse.
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If you select event recording, the DX9000 actually records continuously. The difference between continuous and event
recording is the way the video is saved to the database. When the hard drives are full, the DX9000 starts overwriting the
oldest video.

With continuous recording, the DX9000 overwrites the video in the order in which it was recorded, whether it is an event or a
non-event. With event recording, the DX9000 overwrites non-events first and then events. Data is overwritten on a day-by-day
basis.

To delete a time period:

1. Click “No record.”
2. Click the box.
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Weekly Recording Schedule
1. Select the “Weekly recording schedule” radio button.

2. Click in the time bars the desired starting time for recording for each day of the week or enter the exact start/end times in
the “Fine tune” fields.

The example below shows continuous weekly recording from 7:05 A.M. to 12:05 P.M. The boxes in the time bars are blue with
a red border. You can make the boxes smaller or larger by dragging them using your mouse.

Figure 54.  Continuous Weekly Recording Schedule Page

The example below shows weekly event recording from 7:05 A.M. to 12:05 P.M. The boxes in the time bars are yellow with a
red border. You can make the boxes smaller or larger by dragging them using your mouse.

Figure 55.  Weekly Event Recording Schedule Page

To delete a time period:

1. Click “No record.”
2. Click the box.
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Motion Detection
1. Click the DVMD tab.

Figure 56.  Motion Detection Page

2. Select the “Detector on” radio button.

3. Select the “Preview” checkbox. The video has blue squares over the entire area meaning the entire video has been
selected for motion detection.

4. Click “Clear all” to remove all of the boxes or click the right mouse button on each box you want to remove. To undo your
changes, click “Discard changes.” Click “Mark all” to select the entire video for motion detection.

5. Drag the triangles under the lines to select the minimum time between events and the Video Motion Detection (VMD)
Sensitivity.

6. Click Apply.
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Channel Setup
This section describes how to set camera properties to get the best picture.

1. Click the Video tab.

Figure 57.  Camera Video Setup Page

2. Select the “Preview” checkbox to see the video quality with the default settings.
3. Adjust the video quality.
4. Click Apply.

NOTE:  The bit rate, located under the “Select channel” button, displays the amount of activity in the specified channel.
A higher bit rate requires more storage space. It is important to notice the bit rate as you adjust your camera settings to
achieve the highest quality picture with the lowest bit rate.
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Table C.  Channel Setup

Parameter Description/Action

Channel Name Enter a new name for this channel. You can enter up to 20 characters.

Brightness Drag the triangle to change the brightness value. The higher the value, the higher the bit rate. The
previous value is displayed to the right of the brightness bar.

Contrast Drag the triangle to change the contrast value. The higher the value, the higher the bit rate. The
previous value is displayed to the right of the contrast bar.

Hue Drag the triangle to change the hue value. The previous value is displayed to the right of the hue bar.

Sat V Drag the triangle to increases or decrease the red color in the video. The previous value is displayed to
the right of the Sat V bar.

Sat U Drag the triangle to increases or decrease the blue color in the video. The previous value is displayed to
the right of the Sat U bar.

Vertical This reduces or eliminates video noise. The higher the value, the lower the bit rate. The lower the
value, the higher the bit rate.

Horizontal This reduces or eliminates video noise. The higher the value, the lower the bit rate. The lower the
value, the higher the bit rate.

Black/White Select this checkbox if the channel is connected to a black/white camera. This option ignores video
noise.

White Crush Select this checkbox to reduce the intensity of the white images.
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DEFINING USERS
This option is for system administrators only. Other users trying to access this option will get the following message:

Figure 58.  User Access Dialog Box

This option allows an administrator to add, delete, and change the properties of users in the DX9000 system. There are seven
predefined user access levels ranging from Administrator to Operator Level 6. Each user is assigned different access rights to
the DX9000 network and videos.

Click System > Users on the main toolbar. In the example below, each operator level has been assigned a user name and
password.

Figure 59.  User Manager Dialog Box

Download from Www.Somanuals.com. All Manuals Search And Download.



56 C662M-E (5/03)

Table D.  User Access Rights

Video Locked Export Unlock Video/ Define
Live Video/ Playback/ Video Lock Image/ Change Camera  Users/Audit

User Live Events Query/Sherlock Playback Video Video Settings Viewer

Administrator ✓ ✓ ✓ ✓ ✓ ✓ ✓

Operator Level 1 ✓ ✓ ✓ ✓ ✓ ✓

Operator Level 2 ✓ ✓ ✓ ✓ ✓

Operator Level 3 ✓ ✓ ✓ ✓

Operator Level 4 ✓ ✓ ✓

Operator Level 5 ✓ ✓

Operator Level 6 ✓

Edit Existing Users
1. Select the server name from the “Filter per server” drop-down box. A list of users defined for the selected server appears

under the Users List.

2. Select a user. The user’s properties appear in the Properties panel.

3. Select a new operator authorization level.

4. Select the server name from the “Accessible servers list.”

5. Click OK.

Adding a New User
1. Click New.
2. Enter the user name. This is the login user name.
3. Enter the user’s full name.
4. Enter the user’s password. This is the login password.
5. Re-enter the same password.
6. Select the user’s authorization level: administrator or operator.
7. Highlight the server the user should have access to from the “Accessible servers list.”
8. Click OK.

Deleting a User
1. Select the user name from the “Users list.”
2. Select the server name from the “Accessible servers list.”
3. Click the left arrow button.
4. Click OK.
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ADVANCED PROGRAMMING

I/O INTEGRATION

The DX9000 system can interface to the CM9760 matrix. It can integrate with the CM9760-DT, CM9760-ALM, and CM9760-REL.
You can configure the I/O (input/output) integration feature to send and receive events to the external devices.

The CM9760-DT data translator translates the ASCII protocol to the P protocol of the CM9760 matrix switch.

The CM9760-ALM alarm unit is an input device with 64 ports. You can connect up to four alarm units to each DX9000 recorder.

The CM9760-REL relay unit is an output device with 64 ports. You can connect up to four relay units to each DX9000 recorder.

SENDING EVENTS
The DX9000 sends events to the relay unit and the data translator. The data translator then sends the events to the CM9760
matrix. The events sent are internal events only, such as VMD, Manual, Signal On, and Signal Off.

RECEIVING EVENTS
The DX9000 receives events from the alarm unit. The events are divided into two groups.

Group 1
These are events that are not generated by the system, such as Set Event and Reset Event. These events are generated by
devices such as the alarm unit and have no special meaning for the system. They are translated to either External 1 or External
2 by the I/O Manager before they are recorded in the database and transmitted to the viewstation.

Group 2
These are events that are generated by the system, such as Video Motion Detection Event, Signal Detection Event, No Signal
Detection Event, and Manual Event. These events have a specific meaning in the system. They are not translated. They reach
the viewstation and are recorded in the database.

NOTE:  If the DX9000 receives an unrecognized event, the event is ignored. Events External 1 and External 2 are not valid input
events and can be generated only by the I/O Manager in response to events in Group 1.

I/O CONFIGURATION APPLICATIONS
Each DX9000 recorder has two I/O configuration applications: I/O Handler and I/O Manager.

I/O Handler Configuration
This application allows you to configure the device that the recorder will work with. The I/O Handler can work with a maximum
of two devices at the same time. Each device has its own configuration.

I/O Manager Configuration
This application is the interface between the recorder and the I/O Handler on the same system or over the network. It can work
with several recorders with two devices on each recorder. Each channel has the ability to receive up to two external events at
the same time from two different inputs. Each of the events is marked with a different color. The device is marked as External 1
and External 2 based on the configuration. Each channel can send an event to a single output.
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HARDWARE CONNECTIONS
The I/O configuration allows creating several different connections between the recorder and the external devices.

See the example figures below.

Figure 60.  Hardware Connection 1

In this example, all of the recorders send and receive events from one main recorder (Recorder #1) that is the interface
between the DX9000 and the external devices.

Figure 61.  Hardware Connection 2

In this example, each recorder sends and receives events from its own external devices.

Figure 62.  Hardware Connection 3

In this example, the entire system sends ASCII codes to the CM9760 matrix via the CM9760-DT.
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Connecting an Alarm Unit
To connect a CM9760-ALM to a DX9000 recorder using RS-232 communication:

1. Connect a null modem cable from the alarm unit’s RS-232 port to the COM 1 or COM 2 port on the recorder.

2. Set the DIP Switches on the alarm unit for RS-232 communication. Refer to the CM9760-ALM Installation/Operation
manual.

If using RS-422 communication:

1. Connect a cable from the alarm unit’s RJ-45 COM IN port to the COM 1 or COM 2 port on the recorder via an RS-232 to
RS-422 converter.

2. Set the DIP Switches on the alarm unit for RS-422 communication. Refer to the CM9760-ALM Installation/Operation manual.

Figure 63.  Connecting a CM9760-ALM

NOTE:  You can also connect a CM9760-ALM to an IDE-compatible recorder.
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NULL
MODEM
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Connecting a Relay Unit
To connect a CM9760-REL to a DX9000 recorder:

1. Connect a cable from the relay unit’s RJ-45 COM IN port to the COM 1 or COM 2 port on the recorder via an RS-232 to
RS-422 converter.

2. Set the DIP Switches on the relay unit for RS-422 communication. Refer to the CM9760-REL Installation/Operation manual.

DX9008F-C

USE EITHER
COM 1 OR COM 2

RS-232 TO RS-422
CONVERTER

CM9760-REL

Figure 64.  Connecting a CM9760-REL

NOTE:  You can also connect a CM9760-REL to an IDE-compatible recorder.
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Connecting a Data Translator
To connect a CM9760-DT to a DX9000 recorder:

1. Connect a null modem cable from the CM9760-DT’s COM A port to the COM 1 or COM 2 port on the recorder.
2. Connect a null modem cable from the CM9760-DT’s COM B port to COM 1 or COM 2 port on the CM9760-CC1.
3. Set the jumpers in the data translator for baud rate and parity. Refer to the CM9760-DT Installation/Operation manual.

NOTE:  You can also connect the CM9760-DT to one of the CM9760-CC1 SERCOM ports for RS-422 communication.

Figure 65.  Connecting a CM9760-DT

NOTE:  You can also connect a CM9760-DT to an IDE-compatible recorder.

DX9008F-C

CM9760-DT

CM9760-CC1
USE EITHER
COM 1 OR COM 2

USE EITHER
COM 1 OR COM 2

PRINTER COM 1 COM 2

1 2

COM A

COM B 1 2 12 VAC

RS-232 TO RS-422
CONVERTER
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I/O HANDLER CONFIGURATION

ALARM UNIT INTEGRATION
The following steps show how to configure an alarm unit. This programming is required only on the recorder that is physically

connected to the CM9760-ALM.

1. Go to Start > Programs > DX9000 Server > I/O Handler Configuration.

Figure 66.  Alarm I/O Handler Configuration

2. Click Select Driver to define the external device driver that is connected to the server.

Figure 67.  CM9760 Alarm Driver

3. Select CM9760ALM.dll.
4. Click Open.

Figure 68.  Device 1 Alarm Driver

5. Click Configure.
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Figure 69.  CM9760 Alarm Configuration

Table E.  Alarm Configuration

Term Definition

Baud Rate Set according to the external alarm device settings.

COM Port The COM port on the recorder that the alarm unit is connected to.

Event Type Not used. Set with default value 4.

Event Category Not used. Set with default value 0.

Default Interval The time interval between two events. This sets the same interval for the entire alarm ports.

Armed Alarms Define the port range on your alarm devices. For example, if the recorder is connected to two alarms,
you should have a range of 0-127 because each alarm has 64 ports.

Intervals Setup Alarm: Define the alarm port number that you want to change. The first alarm port on the alarm unit is 0.
Interval: Define the interval time for the desired port that is specified in the alarm.
Add: Set new interval time to the specific port.
Remove: Set the default interval time for the specific alarm port.

6. Set the baud rate to 4800.
7. Enter the COM port that the alarm unit is connected to on the recorder.
8. Click OK.
9. Click Test.
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RELAY UNIT INTEGRATION
The following steps show how to configure a relay unit. This programming is required only on the recorder that is physically
connected to the CM9760-REL.

1. Go to Start > Programs > DX9000 Server > I/O Handler Configuration.

Figure 70.  Relay I/O Handler

2. Click Select Driver to define the external device driver that is connected to the server.

Figure 71.  CM9760 Relay Driver

3. Select CM9760REL.dll.
4. Click Open.

Figure 72.  Device 1 Relay Driver

5. Click Configure.
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Figure 73.  CM9760 Relay Configuration

Table F.  Relay Configuration

Term Definition

Baud Rate Set according to the external relay device settings.

Parity Set according to the external relay device settings.

COM Port The COM port on the recorder that the relay unit is connected to.

Frame Address Not used. Set with default value 0.

Default Latch Time The relay latch time that activates the relays on the relay unit. This sets the same Latch Time
for the entire relay ports.

Momentary Latch Setup Relay: Define the relay port number that you want to change. The first relay port on the relay
unit is 0.
Latch Time: The relay latch time on the relay unit, for a specific port, that activates the selected
relay.
Add: Set new latch time to the specific port.
Remove: Set the default latch time for the specific relay port.

6. Set the baud rate to 9600 and the parity to Even.
7. Enter the COM port that the relay unit is connected to on the recorder.
8. Click OK.
9. Click Test.
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DATA TRANSLATOR INTEGRATION
The following steps show how to configure a data translator unit. This programming is required only on the recorder that is
physically connected to the CM9760-DT.

1. Go to Start > Programs > DX9000 Server > I/O Handler Configuration.

Figure 74.  Data Translator I/O Handler Configuration

2. Click Select Driver to define the external device driver that is connected to the server.

Figure 75.  CM9760 Data Translator Driver

3. Select CM9760DT.dll.
4. Click Open.

Figure 76.  Device 1 Data Translator Driver

5. Click Configure.

Download from Www.Somanuals.com. All Manuals Search And Download.



C662M-E (5/03) 67

Figure 77.  CM9760 Relay Configuration

Table G.  Data Translator Configuration

Term Definition

Baud Rate Set according to the external data translator device settings.

Parity Set according to the external data translator device settings.

COM Port The COM port on the recorder that the data translator is connected to.

Time Synch Update The interval that the recorder updates the CM9760 clock. The default is 21600 seconds (6 hours).

6. Set the baud rate to 4800 and the parity to Even.
7. Enter the COM port that the data translator is connected to on the recorder.
8. Click OK.
9. Click Test.
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I/O MANAGER CONFIGURATION

ALARM UNIT CONFIGURATION
The following steps show how to configure an alarm unit that is installed in the I/O Handler.

1. Go to Start > Programs > DX9000 Server > I/O Manager Configuration.

Figure 78.  I/O Manager Configuration – Overview

2. Click Next.

Figure 79.  Configure External 1 Source
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Table H.  External 1 Source

Term Definition

Server The server name that the alarm unit is connected to.

Port The port number on the alarm unit that relates to a specific channel. If several channels are selected, this
number specifies the related port of the first channel. For example, if 8 channels are selected, port 0 relates
to channel 0 and so on.

Device The logical device number that the alarm unit is connected to and configured on the I/O Handler.

OK Confirm the configuration.

Clear Delete all configurations from the selected channel.

3. Select the channel(s) that will receive events from the alarm unit.
4. Enter the server name that the alarm unit is connected to.
5. Select the device number as configured in the I/O Handler.
6. Enter the alarm port number that the selected channel will receive events from.

NOTE:  The first port on the alarm unit is 0. If you select more than one channel, this port number will be related to the first
channel. The second channel will receive events from alarm port 1, the third channel will receive events from alarm port 2, and
so on.

Figure 80.  Sample Configuration

7. Click OK.
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Figure 81.  External 1

8. Click Next.

Figure 82.  Configure External 2 Source

9. Follow the previous steps if you want to define a second event.
10. Click Next.
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Figure 83.  Configure Event Destination

11. Click Next.

Figure 84.  Configure Output Events

12. Click Finish.
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RELAY UNIT CONFIGURATION
The Step 3 and Step 4 screens in the I/O Manager Configuration are used to configure a relay unit. Step 3 configures the
recorder channels with the selected relay ports. Step 4 translates the event type from one type to another, if necessary.

Figure 85.  Relay Unit Step 3 Screen

 Table I.  Relay Unit Event Destination

Term Definition

Server The server name that the relay unit is connected to.

Port The port number on the relay unit that relates to a specific channel. If several channels are selected, this
number specifies the related port of the first channel. For example, if 8 channels are selected, port 0 relates
to channel 0 and so on.

Device The logical device number that the relay unit is connected to and configured on the I/O Handler.

OK Confirm the configuration.

Clear Delete all configurations from the selected channel.

1. Select the channel(s) you want to configure with the relay unit.
2. Enter the server name that the relay unit is connected to.
3. Select the device number as configured in the I/O Handler.
4. Enter the relay port number that the selected channel will send events to.

NOTE:  The first port on the relay unit is 0. If you select more than one channel, this port number will be related to the
first channel. The second channel will receive events from relay port 1, the third channel will receive events from relay
port 2, and so on.
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5. Click OK and then Next.

Figure 86.  Relay Unit Step 4 Screen

6. Select the event type to translate.

NOTE:  Do not select “Stop Recording” and “Start Recording.” They are reserved for future use.

7. Select “No translation.” You must always select this.
8. Click OK and then Finish.
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DATA TRANSLATOR CONFIGURATION
The Step 3 and Step 4 screens in the I/O Manager Configuration are used to configure the data translator. Step 3 configures
the recorder channels with the selected data translator. Step 4 translates the event type from one type to another, if necessary.

Figure 87.  Data Translator Step 3 Screen

 Table J.  Data Translator Event Destination

Term Definition

Server The server name that the data translator is connected to.

Port The port number on the data translator that relates to a specific channel. If several channels are selected,
this number specifies the related port of the first channel. For example, if 8 channels are selected, port 1
relates to channel 0 and so on.

Device The logical device number that the data translator is connected to and configured on the I/O Handler.

OK Confirm the configuration.

Clear Delete all configurations from the selected channel.
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1. Select the channel(s) you want to configure with the data translator.
2. Enter the server name that the data translator is connected to.
3. Select the device number as configured in the I/O Handler.
4. In the port field, enter the alarm number you want to activate in the matrix.

NOTE:  In the port field, you can enter and configure only alarm numbers (physical and logical numbers in the CM9760
System Manager). If you select several channels, the port number you enter will be the starting port. That means the first
port on the data translator is 1.

5. Click OK and then Next.

Figure 88.  Data Translator Step 4 Screen

6. Select the event type to translate.

NOTE:  Do not select “Stop Recording” and “Start Recording.” They are reserved for future use.

7. Select “No translation.” You must always select this.
8. Click OK and then Finish.

Download from Www.Somanuals.com. All Manuals Search And Download.



76 C662M-E (5/03)

DVR MANAGEMENT

The Server Alert Configuration Utility can be used to send events to the CM9760-DT data translator or the CM9760-REL relay
unit.

The server state sends a string to the data translator. The string is different for each recorder so the matrix recognizes which
recorder has the problem.

The server state activates the relay unit. The server state is configured to activate a specific relay port in case of a problem.

DATA TRANSLATOR CONNECTIONS
The CM9760-DT should be used with Pelco matrix switchers, such as the CM9760 matrix.

1. Connect a null modem cable from the CM9760-DT’s COM A port to the COM 1 or COM 2 port on the viewstation.
2. Connect a null modem cable from the CM9760-DT’s COM B port to the COM 1 or COM 2 port on the CM9760-CC1.
3. Set the jumpers in the data translator for baud rate and parity. Refer to the CM9760-DT Installation/Operation manual.

NOTE:  You can also connect the CM9760-DT to one of the CM9760-CC1 SERCOM ports for RS-422 communication.

Figure 89.  Connecting a CM9760-DT for DVR Management

DX9000-VS

CM9760-DT

CM9760-CC1

USE EITHER
COM 1 OR COM 2

PRINTER COM 1 COM 2

1 2

COM A

COM B 1 2 12 VAC

RS-232 TO RS-422
CONVERTER

NULL MODEM
CABLE

USE EITHER
COM 1 OR COM 2

NULL
MODEM
CABLE
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CONFIGURING THE DATA TRANSLATOR
1. Go to Start > Programs > DX9000 Viewstation > Server Alert Configuration Utility.

Figure 90.  Data Translator Configuration

2. Enter the offset number in the Server Alert Settings box.

NOTE:  The offset number must match the logical and physical numbers of the first alarm in the CM9760 System Manager.

3. Click Select.

Figure 91.  Data Translator Driver

4. Select CM9760DT.dll.
5. Click Open.

Figure 92.  Data Translator Driver Settings
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6. Click Configure.

Figure 93.  CM9760-DT Configuration

Table K.  CM9760-DT Settings

Term Definition

Baud Rate Set the baud rate according to the data translator settings.

Parity Set the parity according to the data translator settings.

COM Port This is the COM port on the viewstation that the data translator is connected to.

7. Set the baud rate to 4800 and the parity to Even.
8. Enter the COM port that the data translator is connected to on the viewstation.
9. Click OK.

10. Click Test.

NOTE:  Once you complete programming, refer to the CM9760-MGR manual for instructions on macro programming for the
matrix switcher. Individual macro commands must be customized within the CM9760-MGR software to switch the appropriate
group of cameras to the monitors connected to the standby DX9000.
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USE EITHER
COM 1 OR COM 2

RS-232 TO RS-422
CONVERTER

CM9760-REL

DX9000-VS

RELAY UNIT CONNECTIONS
You can connect 1 to 4 relay units to each viewstation. The CM9760-REL should be used with third party matrix switcher for
hard-wired alarm integration.

1. Connect a cable from the relay unit’s RJ-45 COM IN port to the COM 1 or COM 2 port on the viewstation via an RS-232 to
RS-422 converter.

2. Set the DIP switches on the relay unit for RS-422 communication. Refer to the CM9760-REL Installation/Operation
manual.

Figure 94.  Connecting a CM9760-REL for DVR Management
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Figure 97.  Relay Unit Driver Settings

6. Click Configure.

CONFIGURING THE RELAY UNIT
1. Go to Start > Programs > DX9000 Viewstation > Server Alert Configuration Utility.

Figure 95.  Relay Unit Configuration

2. Enter the logical relay number in the Server Alert Settings box.
3. Click Select.

Figure 96.  Relay Unit Driver

4. Select CM9760REL.dll.
5. Click Open.
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Figure 98.  CM9760-REL Configuration

Table L.  CM9760-REL Settings

Term Definition

Baud Rate Set the baud rate according to the External Relay device settings.

Parity Set the parity according to the External Relay device settings.

COM Port This is the COM port on the viewstation that the relay unit is connected to.

Frame Address This should be set with the default values of 0.

Default Latch Time (sec) The minimum time that is detected by the relay unit. This sets the latch time for all the relay
ports.

Relay Define the relay port number that you want to change. The first port on the relay unit is 0.

Latch Time (sec) The minimum time that is detected by the relay unit for the specific port.

Add Set the new latch time for the specific port.

Remove Set the default latch time for the specific relay port.

7. Set the baud rate to 9600 and the parity to Even.
8. Enter the COM port that the relay unit is connected to on the viewstation.
9. Click OK.

10. Click Test.
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FOREIGN LANGUAGE

You can select only the following locations for use with the DX9000 system:

• English (United States)
• French (France)
• German (Germany)
• Portuguese (Brazil)
• Spanish (Spain)

In the example below, the location is changed from English (United States) to Spanish (Spain).

1. Double-click My Computer.

Figure 99.  My Computer

2. Double-click Control Panel.
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Figure 100.  Control Panel

3. Double-click Regional Options.

Figure 101.  Regional Options
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4. Change the location to Spanish (Spain).

Figure 102.  Change System Location

5. Click Apply.
6. Click Set Default.

Figure 103.  Select System Location

7. Select the same location.
8. Click OK.
9. Click Apply.
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Figure 104.  General Dialog Box

10. Click Yes.

Figure 105.  Restart Computer Dialog Box

11. Click Yes.

The new settings take affect after the computer reboots. The DX9000 will support Spanish settings for numbers, currency,
times, dates, menu strings, and text translations.

Follow these same steps to change the location back to English (United States) or to select another location.

NOTE:  English (United States) is the default location.
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TROUBLESHOOTING

If you encounter a minor problem with your computer, monitor, or software, refer to the following list of general suggestions
before taking further action:

• If you cannot log in to the system, check your user name and password.
• Make sure the computer and monitor are plugged into a working electrical outlet.
• Make sure the computer’s green power light is on.
• Make sure the monitor’s green light is on.
• If the monitor is dim, adjust the brightness and contrast controls.
• Check all cable connections for loose connections or incorrect connections.
• Remove all diskettes when you turn your system on.
• Contact your local support center for further assistance.
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SPECIFICATIONS

RECORDER

Electrical/Video
Input Voltage: 100-240 VAC, 50/60 Hz, autoranging
Power Consumption: 195 W maximum
Signal System: NTSC/PAL
Operating System: Windows 2000 and SP2 Service Pack
Recording Resolution

NTSC: 352 x 240 pixels
PAL: 352 x 288 pixels

Compression: MPEG
Compressed Image Size: 352 x 240: average 1.4 KB for indoor, fixed camera
Video Inputs: 8/16/24 at 30 ips

8/16/24/32/40 at 15 ips
Video Outputs: 1 (SVGA)
Remote Control: Full remote control via TCP/IP network

Mechanical
Connectors

BNC: Video inputs
6-pin mini-DIN: PS/2 mouse and keyboard
DB9: COM 1 and COM 2
DB15: Monitor port (SVGA)
RJ-45 Ethernet port (10/100 BaseT)

General
Operating Temperature: 41° to 85°F (5° to 29°C)
Relative Humidity: Maximum 80% noncondensing
Dimensions

Desktop: 7.3 (H) x 17.0 (W) x 19.6 (D) inches (18.5 x 43.2 x 49.8 cm)
Rack-Mount: 7.0 (H) x 19.0 (W) x 19.6 (D) inches (17.8 x 48.3 x 49.8 cm)

Unit Weight: 40 lb (18.1 kg) maximum (fully equipped)

VIEWSTATION

Electrical
Input Voltage: 100-240 VAC, 50/60 Hz, autoranging
Power Consumption: 50 W maximum
Operating System: Windows 2000 and SP2 Service Pack

Mechanical
Connectors

6-pin mini-DIN: PS/2 mouse and keyboard
DB9: COM 1 and COM 2
DB15: 1, composite video (analog adapter provided)

1, SVGA, 1024 x 768
DB25: Printer port
RJ-11: Internal modem (for use with pcAnywhere software only)
RJ-45: Ethernet port (10/100BaseT)
USB: Not used

General
Operating Temperature: 41° to 85°F (5° to 29°C)
Relative Humidity: Maximum 80% noncondensing
Dimensions

Desktop: 7.3 (H) x 17.0 (W) x 19.6 (D) inches (18.5 x 43.2 x 49.8 cm)
Rack-Mount: 7.0 (H) x 19.0 (W) x 19.6 (D) inches (17.8 x 48.3 x 49.8 cm)

Unit Weight: 33 lb (15.0 kg)
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REGULATORY NOTICES

This equipment has been tested and found to comply with the limits of a Class A digital device, pursuant to part 15 of the FCC
rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.
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REVISION HISTORY

Manual # Date Comments
C662M 6/02 Original version.
C662M-A 9/02 Updated parts list on page 5. Revised Figure 2.
C662M-B 2/03 Revised Network Configuration and Time Synchronization sections.
C662M-C 4/03 Incorporated DX9000 Digital Video Recorder Installation/Operation manual (C685M-D). Revised manual for version C1.1 software.
C662M-D 5/03 Added Installation Guidelines section. Revised to include IDE storage and recorder models.
C662M-E 5/03 Removed storage units from Models section. Added parts list. Revised Figures 1 through 4. Added note to Mylex Alert Manager section. Added notes to Hardware

Connections section. Removed SCSI and IDE storage units from Specifications.

® Pelco, the Pelco logo, Spectra, Genex, Esprit, Camclosure, and Legacy are registered trademarks of Pelco. ® Windows is a registered trademark of Microsoft Corporation.
™ pcAnywhere is a trademark of Symantec. © Copyright 2003, Pelco.All rights reserved.

WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in material or
workmanship for a period of one year after the date of shipment. Exceptions to this warranty are
as noted below:

• Five years on Pelco manufactured cameras (CC3500/CC3600/CC3700 and MC3500/MC3600
Series); two years on all other cameras.

• Three years on Genex® Series (multiplexers, server, and keyboard) and 090 Series Camclosure®

Camera System.
• Two years on 100/150, 200 and 300 Series Camclosure® Camera Systems.
• Two years on cameras and all standard motorized or fixed focal length lenses.
• Two years on Legacy®, CM6700/CM6800/CM6800E/CM8500/CM9500/CM9740/CM9760

Matrix, DF5 and DF8 Series Fixed Dome products.
• Two years on Spectra®, Esprit®, and PS20 Scanners, including when used in continuous

motion applications.
• Two years on Esprit and WW5700 series window wiper (excluding wiper blades).
• Eighteen months on DX Series digital video recorders.
• One year (except video heads) on video cassette recorders (VCRs). Video heads will be

covered for a period of six months.
• Six months on all pan and tilts, scanners or preset lenses used in continuous motion applica-

tions (that is, preset scan, tour and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of Pelco
shipment. All goods requiring warranty repair shall be sent freight prepaid to Pelco, Clovis,
California. Repairs made necessary by reason of misuse, alteration, normal wear, or accident
are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss resulting from the
specific use or application made of the Products. Pelco’s liability for any claim, whether based on
breach of contract, negligence, infringement of any rights of any party or product liability, relating
to the Products shall not exceed the price paid by the Dealer to Pelco for such Products. In no
event will Pelco be liable for any special, incidental or consequential damages (including loss of
use, loss of profit and claims of third parties) however caused, whether by the negligence of
Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may also have
additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or (559) 292-1981 to
obtain a Repair Authorization number (RA), and provide the following information:

1. Model and serial number
2. Date of shipment, P.O. number, Sales Order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product which does not fall under the warranty conditions
stated above, please include a written explanation with the product when returned.

Method of return shipment shall be the same or equal to the method by which the item was received by
Pelco.

RETURNS
In order to expedite parts returned to the factory for repair or credit, please call the factory at (800) 289-9100
or (559) 292-1981 to obtain an authorization number (CA number if returned for credit, and RA number if
returned for repair).

All merchandise returned for credit may be subject to a 20% restocking and refurbishing charge.

Goods returned for repair or credit should be clearly identified with the assigned CA or RA number and
freight should  be prepaid. Ship to the appropriate address below.

If you are located within the continental U.S., Alaska, Hawaii or Puerto Rico:
Service Department
Pelco
3500 Pelco Way
Clovis, CA 93612-5699

If you are located outside the continental U.S., Alaska, Hawaii or Puerto Rico:
Intermediate Consignee Ultimate Consignee
American Overseas Air Freight Pelco
320 Beach Road 3500 Pelco Way
Burlingame, CA 94010 Clovis, CA 93612-5699
USA USA
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USA & Canada
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International
Tel: 1-559/292-1981
Fax: 1-559/348-1120

www.pelco.com
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